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Brief Overview of ArcGIS 

ArcGIS is a software program, used to create, display and analyze geospatial data, developed by Environmental Systems Research Institute (ESRI) of Redlands, California. ArcGIS consists of three components: ArcCatalog, ArcMap and ArcToolbox. ArcCatalog is used for browsing for maps and spatial data, exploring spatial data, viewing and creating metadata, and managing spatial data. ArcMap is used for visualizing spatial data, performing spatial analysis, and creating maps to show the results of your work. ArcToolbox is an interface for accessing the data conversion and analysis function that come with ArcGIS. ArcGIS comes in three variants: ArcView, ArcEditor, or ArcInfo, which are the low end, middle and fully configured versions of the software.   Any of these versions can be used for this exercise.  The instructions in this exercise are illustrated using the tools in ArcGIS version 9.2.


Goals of the Exercise

This exercise introduces you to ArcMap and ArcCatalog.   You use these applications to create a map of pan evaporation stations in Texas, and to draw a graph of monthly pan evaporation data measured at these stations.    The relationship between ArcGIS and MS Word and Excel is demonstrated so that you can create graphs in Excel, maps in ArcGIS and place the result in a Word file as a report for this homework.   You use ArcCatalog to create a new personal geodatabase and import shapefiles to a feature dataset.



Computer and Data Requirements

To carry out this exercise, you need to have a computer, which runs ArcGIS. 

You will be working with the following spatial datasets during this exercise: 

1. A polygon shapefile of the counties of Texas, called Counties 

2. A point shapefile of pan evaporation stations, called Evap 

3. A polygon shapefile of the state of Texas, called Texas 

These shapefiles consist of several files (e.g. evap.dbf, evap.shp, evap.shx). You can get them from this Winzip file:   Ex1.zip which you have to unzip using the Windows utility Winzip. You need to establish a working account to do the exercise on.    This can be in c:\temp or on a memory stick attached to the machine you are working on.   To establish a new account at the CE Learning Resource Center, go to http://www.ce.utexas.edu/lrc/ and select CE-LRC User Accounts.  If you don't yet have a regular NT Login account at the LRC, get a temporary guest login to do the exercise.     
After you have downloaded the Winzip file,ex12007.zip double click on the Winzip file and you should see the Winzip or the Alladin Stuffit utility open on your computer (if it doesn’t open you’ll have to unzip this file on a computer with Winzip or Alladin Stuffit operational).   If queried, agree to use the Winzip system, then you’ll be presented with a list of the files inside the Winzip folder.    Use Action/Select All to select all these files, then Action/Extract to extract them to the working folder that you’ve set up to do this exercise.  You should end up with a file list that looks something like this.   You may see these data within a sequence of folder names, and if so, click on each folder down through the sequence until you locate the required files.
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ArcGIS License Server

This exercise can be executed with any of the options within ArcGIS, namely ArcInfo, ArcEditor or ArcView.    Each of these systems provides access to ArcMap and ArcCatalog, which are the ArcGIS interfaces used to do the work.    When you invoke ArcMap or ArcCatalog, it is possible that you will get a message saying that all the licenses for ArcInfo are in use on the network, or that you aren’t licensed for this application.     In that event, you need to switch to another version of the software with available licenses.   To do this, from Windows use Start/Programs/ArcGIS to invoke the ArcGIS Desktop Administrator, and select another version.  In the LRC, ArcView [Single Use] works best, but in another lab setting, the ArcView [floating] or ArcEditor  [floating] could be the right choice, depending on license availability.
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Procedure

Please note that the following procedure is a general outline, which can be followed to complete this lesson. However, you are encouraged to experiment with the program and to be creative. 

1. Viewing Shapefiles 

A shapefile is a homogenous collection of simple features that do not contain topological information. The format was introduced with ArcView 2.0 to simplify the representation of spatial data. A shapefile includes geometric features and their attributes. The attributes are contained in a dBase table, which allows for the joining with a feature based on the attribute key.

Viewing Shapefiles in ArcMap
(1) Open ArcMap and select the A new empty map option.
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(2) Use the [image: image5.png]


(Add Data) button to add the exercise data for this exercise. Navigate to the folder, which contains the data, and select all three files at once by using the shift key. Click the Add button to import the images.   If you are using a network drive to obtain your files use the [image: image6.png]


 button to add the network drive to the ones that ArcMap is accessing so you can get to the files.
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In ArcMap, a layer consists of a reference to a spatial dataset (such as a feature class, shapefile or coverage) and a definition of how to display it (legend colors, line thickness, etc.), and a map is a graphical representation of geographic information. The left panel in the ArcMap window is the Table of contents, and the right panel is the Display window. In the middle is Arc Toolbox, whose use we will cover later.  Click this off so that you just have the Table of Contents and the Map Display panels displayed. The Table of contents lists layers, and the Display window displays maps.  You may get a message that says that “one or more layers lacks spatial reference information and can’t be projected”.  Don’t worry about this.  The Texas polygon layer has a projection file (Texas.prj) and the other files are in the same coordinate system.  We’ll deal more with projections in later exercises.  As you can see it is very simple to add shapefiles to ArcMap.

(3) Click off the check marks next to the layer names in the left hand column. Click on each layer name individually to that you may view what features that layer contains. 
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When you are done exploring the possibilities of ArcMap, exit the program. You do not need to save the file since you will be coming back to ArcMap later in the exercise.

Preview Shapefiles in ArcCatalog 
(4) Open ArcCatalog 
Arc Catalog is like a Windows Explorer for GIS files.  It helps you to quickly explore what data you have.
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(5) On the left panel, search for the folder where the exercise data is located. 
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In ArcCatalog, you can toggle the right panel display between a file tree (Contents tab), a data view (Preview tab), and a metadata document (Metadata tab). 

(6) Highlight the layer for the Counties shapefile and click on the Preview tab in the right panel. First look at the Geography preview.
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You can see the layer represents the outline of Texas. The Preview option allows you to display the feature class table as well, by selecting Table instead of geography at the bottom of the panel. 
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If you click on the Metadata tab, you’ll see descriptive information about the Counties layer:
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Click on the other two data layers to preview them also.

2. Creating Geodatabases, Feature Datasets, and Feature Classes

A geodatabase is a relational database that stores geographic information. A relational database is a collection of tables logically associated with each other by common key attribute fields. A geodatabase can store geographic information because, besides storing a number or a string in an attribute field, tables in a geodatabase can also store geometric coordinates to define the shape and location of points, lines or polygons.  Note that a single table can store only one type of spatial feature (point, line or polygon) and not a mixture of feature types. A personal geodatabase is a file with extension .mdb, which is the file extension used by Microsoft Access.  

A feature dataset is a collection of feature classes that share the same spatial reference.  The spatial reference describes both the projection and spatial domain extent for a feature class in the geodatabase. Because the feature classes in a feature dataset share the same spatial reference, they can participate in topological relationships with each other such as in a geometric network. These topological relationships can also be stored in the feature dataset. Note that feature classes in a geodatabase can exist as stand-alone feature classes, without being part of any feature dataset.

A feature class is a collection of features with similar geometry. There are point, line, and polygon feature classes. Two types of feature classes exist: simple feature classes and topological feature classes. A simple feature class includes features that have no topological associations among them and features maybe edited independently of each other. Topological feature classes are bond as one integrated topological unit, such as a geometric network that we’ll explore later in this class.

Create a new Geodatabase 

(1) To create a new geodatabase in Arc Catalog first right click on the folder that contains the data for the exercise. Select New/Personal Geodatabase and a new geodatabase -- called New Personal Geodatabase.mdb and represented by an icon with the shape of a cylinder -- will be created.   Note – a File Geodatabase is an alternative form that stores the data in a file system instead of as an Access file.   It can be faster to do this but this is not important for this exercise.
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and (2) name the geodatabase Ex1Data (the geodatabase will keep its file extension mdb regardless of whether you included it in the name or not).   You can right click on the geodatabase name and use Rename to rename the file.
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Adding Data to the Geodatabase 

When first loading data into a geodatabase, it is important to think about the data and how they are related. As mentioned above, in geodatabases the data is placed in feature classes that are then organized into feature datasets. A geodatabase can have one or more feature datasets. Each feature dataset has a single reference frame, which includes the map projection and map extent. It is possible to define the reference frame after the creation of the feature dataset and before data is loaded. 
Create a New Feature Dataset

We will create a new feature dataset within this geodatabase to define the spatial reference of our data.  Right click on the Ex1Data.mdb geodatabase and select New Feature Dataset.
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Name the new feature dataset Texas, and hit Next to set the spatial reference frame.
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Select Import in the screen which appears and then select Texas.shp.  
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This has the effect of assigning the coordinate system and spatial extent of the Texas.shp theme to the Feature Dataset.   
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Click Add and then Next and you will be asked to select a vertical coordinate system
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In this case, we don’t have vertical coordinates (z-values) so we’ll just accept “none” and hit Next .  You’ll now be asked to select tolerances for various coordinate systems.  Just “accept the default resolution” and hit Finish .  Note that this process of setting up a Feature Dataset in ArcGIS version 9.2 is significantly different than in earlier versions and avoids a problem of your being forced to set a spatial bound on the extent of your data that caused considerable difficulties in this class in previous years.
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have a new feature dataset called Texas.
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And if you view the “spatial” component of the metadata for this feature dataset, you’ll see that you are using NAD_1983_Albers projected coordinate system.  
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And if you click on details, you’ll see some more information about the parameters of this coordinate system. You’ll learn what this means in your next exciting lecture on map projections and coordinate systems!
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To import the shape files into the feature dataset, right click on the Texas feature dataset and select Import Feature Class (single)
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You’ll see a Green Dot  next to Input Features – browse for the shapefile Texas and click to import it. Type the name Texas into the Output Feature Class Name field:   
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Click Ok and a new feature dataset called Texas will be created within the Ex1Data geodatabase, and within that a new feature class called Texas will exist which contains the outline of the state of Texas.
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And if you view the Geography of this feature class in Arc Catalog, you’ll see:
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If you check the file list for the shape files that you opened at the beginning of this exercise, you’ll find that the Texas shape file is the only one that has a .prj file and the Counties and Evap shape files don’t have a .prj file, which means that they have a coordinate system but it is undocumented in your dataset.  It happens that these shape files have the same coordinate system as the Texas shape file so when they are imported into the geodatabase, they overlay correctly in the same spatial reference.   If you get shape files or coverages with undocumented coordinate systems, it can be a real headache to figure out what the correct coordinate system is.   Fortunately, ArcGIS version 9 automatically documents the coordinate system on each shape file, but earlier versions of ArcView did not, and you may encounter the problem of undocumented coordinate systems when loading older shape file data.

Ok, lets continue with the exercise.

Import the other shape files for Counties and Evaporation to the feature dataset in a similar way that you just did for the Texas outline.   You may see some messages in Green about the resolution of the output feature class being greater than for the input feature class.  Don’t worry about this.
After creating the geodatabase, the feature dataset and the feature classes, the ArcCatalog tree looks like this: 
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Note that the feature classes Texas, Counties, and Evap could have been created outside the feature dataset Texas, but since they share the same spatial reference, it was decided to group them together within the feature dataset. Trying to import spatial data to an existing feature dataset may cause a conflict between different spatial reference frames. This is very likely to occur when attempting to import data to an empty feature dataset created without first defining its spatial reference.  You’ll learn more about how to define spatial references in Exercise 2 in this class.

3. Displaying Feature Datasets in a Map

We will now add the feature dataset that we created in ArcCatalog to an ArcMap document.  To display the spatial data of the Texas feature dataset in a map, first open ArcMap.    

(1) You can launch ArcMap from within ArcCatalog usign  [image: image31.png]


 or you can open ArcMap from the Start menu as you did before.  Close Arc Catalog.  In ArcMap, click on the Add Data button, [image: image32.png]


.  

(2) Browse to the feature dataset Texas, 
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and click Add. This has the effect of adding all the feature classes in the feature dataset to the ArcMap display.  You can add individual feature classes within the Texas feature dataset if you so desire, by clicking on the feature dataset icon, and then on the icons of one or more of the feature classes (Hold down Ctrl or Shift to select more than one feature class). 

Note that the Table of Contents lists the layers corresponding to the three feature classes of the Texas feature dataset that you just added, while the Display window displays the map with the corresponding spatial data (i.e., Texas counties and evaporation stations).  When I loaded up my feature dataset, I found that the Texas outline map is plotted above my Counties so I can’t see my County boundaries.   
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This is fixed by dragging the Counties feature class up in the list of Layers so that it is above the Texas layer.  The order in which the feature classes are displayed is the order they are listed in the Layers.
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(3) Save your work in ArcMap by choosing File/Save and, after navigating to your working directory, naming the file Ex1 (the file will be assigned the extension mxd).    When you do this, the Ex1.mxd file contains the file location of the geodatabase and the symbology you’ve chosen for the map display.  You can shut down Arc Map and then invoke Arc Map again and reload the same map display by clicking on Ex1.mxd.  Note, however, that if in the mean time you’ve relocated your geodatabase, ArcMap will go back to where you had it at the time the map file was saved.  
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________________________________________________________________________
Helpful Tip:
If you open your ArcMap Ex1.mxd file later from another location in your file system, you may see a red exclamation points beside your feature classes.  If this happens, in ArcMap, right click on the feature class use Data/Set Data Sources to relocate the file location where the corresponding data are now stored and your map will display correctly again.   It does not matter where the Ex1.mxd file is stored, you can move that around wherever you want, but it does matter where the data referred to in that file are stored.   ArcGIS 9.2 is a good deal more clever at dealing with file locations than earlier versions were so you may not encounter this problem.
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________________________________________________________________________

Ok, lets continue on with the exercise.

(4) To change the appearance of a map display, you can access the Symbology menu just by double clicking on the Symbol
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displayed in the ArcMap Layers, and you’ll get the Symbol Selector window 
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Click on the symbol color box, make your selections for the Fill Color and the Outline Color, and click OK, twice. Follow this procedure to modify the display of the Counties layer. Hopefully, the new map looks better than the original one.    You can show the outline of the State of Texas more distinctly by using the Hollow symbology for the Texas polygon and then changing the Outline Width to 2 or 3.  Otherwise the Texas layer is obscured behind the Counties layer and you won’t see it.

More complicated symbol shading that has the color and size of the symbols varying according to attributes of a feature class, can be manipulated by accessing the of the Properties of the Symbology of the Feature Class.
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4. Accessing and Querying Attribute Data
Numerical and text information stored in the fields of the geodatabase tables are called attributes.   To access attribute data of the feature classes at a specific location:
(1) Click on the Identify Features tool [image: image41.png]


 which is contained within the “Tools” menu.  If you don’t see this set of tools on your ArcMap document, use View/Toolbars and click on Tools to make it appear.
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(2) Click on the feature on the map you are interested in, and in the Identify Results window, select the object you are interested in. In the figure, attribute data for the Austin Airport evaporation station in Travis County has been retrieved (Travis County is where Austin and the University of Texas are located).  I have used the Zoom button [image: image43.png]


 to zoom into the middle of the state where Travis County is located to create the next picture:
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If you inadvertently close the Tools menu you just used, you can open it again from the View menu: 
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Viewing an Attribute Table 

(3) Tables that contain attribute data of a layer are always called Attributes of <layer name>, and contain a field called Shape. The field Shape displays the words Point, Line or Polygon, but it really stores a geometric object with the shape of a point, line or polygon. To access attribute data of an entire layer, in ArcMap: right click on the Evap layer name in the table of contents, and select Open Attribute Table: 
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And if you scroll down and click on ObjectID 44 you’ll see the record that contains the attributes of the Austin Airport station that you identified earlier.  Click on this to select it, and you’ll see the corresponding point selected in the map – this is a key idea of GIS – map features are described by records in attribute tables.
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All attribute data is the same as retrieved before, except for the Shape field, but that does not mean that the table stores information different from what can be retrieved with the Identify Features tool.   

(4) To Clear a Selected feature and select a new one, use: Selection/Clear Selected Features in the ArcMap toolbar: 
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5. Selecting features from a feature class (points, lines and polygons)

Selecting features from a feature class involves choosing a subset of all the features in the class for a specific purpose. Feature selection can be made from a map by identifying the geometric shape, or from an attribute table by identifying the record. Regardless of how you select an object, both the shape in the map and the record in the attribute table will be selected.    To choose a particular data layer for selection use Selection/Set Selectable Layers and then click off the layers that you don’t want to have selected.   Be careful when using this Set Selectable Layers function because if you later want to select features from another class, you’ll have to go back and change this selection to your new class.
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(1) To select an object from the map, in ArcMap: click on the Select Features tool  [image: image51.png]


, in the Tools menu

(2) Zoom to the full extent of the map, by using the [image: image52.png]


 button on the Tools menu. Click on the Counties polygons you want to select. To select more than one object, press the Shift key and hold it down while you click on the additional objects. Selected objects are displayed with a light blue outline, although the color might change depending on your settings. The corresponding attribute table records have also been selected. You can verify this by opening the Counties attribute table, and hit Selected at the bottom of the attribute table to show just the Selected Counties.
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(3) To clear your selection, right click on the layer name, and choose Selection/Clear Selected Features. 

6. Making a Chart

Charts are useful because they allow you to visualize trends in data. ArcMap has chart-making capabilities. We will plot a chart of one or more records selected from a geodatabase table. 

(1) Use Selection/Set Selectable layers to show only the Evap data layer.  
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Select the two evaporation points that are located in Travis County.  Travis County is located in Central Texas and has a characteristic shape like a tooth!   If you open the Evap attributes table and hit Selected, you’ll see just the evaporation records for these two stations (one at the airport, and one at Mansfield dam which creates Lake Travis, a large lake near Austin).  If you scroll across, you’ll see some attributes from January to December and an Annual value.  These are average pan evaporation values in inches for each month and year compiled from historical data measured at these locations.
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To create a chart, choose Tools/Graphs/Create, this opens the Graph Wizard.
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(2) You will be making a Column chart (the default option).  The next screen will allow you to indicate the data to be used in the graph.   Here is a graph of the Annual Evaporation of the two stations plotted against a backdrop of all the stations in Texas:
[image: image57.png]Create Graph Wizard

Graph type;
[l vertcartr <] Graph of Evap
Layer(Table:

vl el T —
el ool e =]
Xisel el e —
Vet s P —
N

[ addtolegend [ show labels (marks)

caor e a—
sty ra—
T el
sz () !

I~ show barder

ANN_VAL

BT
OBJECTID

Vertical Bar

add ! Load Template ~|





Hit Next and edit the graph properties to make them nicer:
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Press Finish. You have created a graph in ArcMap!!
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Another option is to make a chart in Excel using the dBase tables given by the evaporation shapefile.  Open the evaporation attributes table evap.dbf as a table in Excel.  Use Files of Type: dBase files in Excel to focus only on .dbf tables when you open the table.  Select the stations you want to plot, copy their records to a new worksheet, delete the columns you don't need there, and then create a chart.   Here is an example chart created this way.   The column headers have been renamed from Jan_Val to Jan, etc to make the Chart x-axis more attractive to view.    The legend has been moved to the top of the chart to allow a wider spacing of the data in the chart.   I copied the data for Mansfield Dam and Austin airport into a new spreadsheet to make this chart.
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____________________________________________________________________________ 

Helpful Tip:

Instead of opening the evap.dbf file in Excel, you could have accessed the same data directly from the geodatabase using Data/Get External Data in Excel

[image: image61.png]3 Microsoft Excel - Book1

el | o ot
DEEaRY[sb@ o | il Bl

Al Eiter »

A "B [ ¢ [ Ffm

Subtotals

Valdation

1
2

3

) Tabe

5 Textto Colmns
5

7

6

Consoldate,
roup and Outine »

tvatTable and PivotChert Repart.

D | e, YRR

12 - @ NewWebQuerw.
13 @l
14 ] tmport Text i




Navigate to the geodatabase and select the table Evap.  Then select the fields that you want to appear in the spreadsheet.   You’ll end up with a spreadsheet containing the data for all the fields you’ve selected.

Ok, lets continue with the exercise.

7. Creating a Map Layout

To consolidate a map of counties of Texas with evaporation stations with the graph that you created before in a single sheet of paper, in ArcMap: (1) change the format of the display window from Data View to Layout View by clicking on View/Layout View, 
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If your Layout doesn’t display properly in ArcMap, hit [image: image63.png]2n ]



 at the bottom of the map display to refresh it.
Reduce the size of the data frame in the layout (i.e., rectangle where the spatial data is contained) -- to make room for the graph -- by clicking on the graph and moving its handlers.   If you have a zoomed in view in Arc Map, you’ll get the same image in in the Layout.  To go back to the image of the whole State of Texas, right click on the Texas data layer in the legend and select Zoom to Layer.  
[image: image64.png]



To insert the ArcMap Chart into the Layout, right-click on upper blue bar at the top of the Chart and select Show on Layout.  Move and resize the graph as necessary.  If you want to copy your graph from Excel, highlight the graph, and click on Copy on Excel, then Paste in ArcMap and your graph should appear in the map layout.
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You can draw lines to relate the location of the measurement stations and the data plotted on the graph using the Draw a Line tool from the ArcMap Draw toolbar (to display this Toolbar, use View/Toolbars and select Draw).   This draw toolbar works the same in ArcMap as it does in other MS applications.  It is important to show some association between the data plotted on the chart and where these data were measured on the map so that you can figure out which data series was measured at what location. 
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Or you can add text with the text tool [image: image67.bmp]shown next to the line draw tool.   You can also insert a North Arrow by using the Insert menu in ArcMap. 
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Your map might look like this:
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You can export your map from ArcGIS using File/Export Map from the ArcMap menu, and you can store this as Ex1.emf in your data file (don’t worry that it has 0kb size).  Then you can add it to a Word document using Import/Picture/From File and load this emf file, as shown below.  Pretty cool!
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Here's another option: suppose you want to take a chart in Excel and add a map to the Chart to show where the data apply.   If you Copy the Map to the Clipboard in ArcMap, you can Paste it in Excel and annotation to connect the map to the Charted data.  You can see that in this map, a nice color association between the symbols on the map and the bars on the chart makes it clear which data series was measured at which location.  This chart shows a different pair of evaporation stations that are color code at their geographic locations so you can see how the pattern of evaporation varies geographically.
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The manipulations just described transfer objects from one application to another.  

___________________________________________________________________________

Helpful Tip:

A more general procedure is to simply copy the screen to the clipboard and cut out the part that you want, saving it to a file for later use.   That is how all the images in this exercise were prepared.  To copy any image, hit Shift/Print Screen on your keyboard (this copies the Screen onto the Clipboard).   From the Start Menu in Windows, Open Accessories/Paint. 
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Here’s how your map display may appear in Paint:
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In Paint, use File/New to select a new file, then Edit/Paste to paste the contents of the Clipboard into Paint.  If asked whether you want to enlarge the bitamp say Yes.  You'll now see an image of all the things on your original computer screen.  Click on the open box [image: image74.png]


 under Edit so that the cursor becomes a cross and use it to draw a dashed box around the portion of the image that you want to keep. Use Edit/Copy 
Then in Word, you can use Paste to insert the .bmp file into Word.   Note that in ArcMap you can use Insert/Picture to similarly insert pictures into your maps!!  Very cool! 

___________________________________________________________________________

Ok, lets continue with the exercise.

To be turned in: An ArcMap map layout in it showing a map of Texas with gages, and linked with a graph showing monthly evaporation data plotted from one or two gages.

8. Learn about Google Earth
An addendum to this exercise that explores the how to use the same data as in this exercise in the context of Google Earth is available at http://www.ce.utexas.edu/prof/maidment/giswr2006/Ex1/Ex12006Google.doc 



These materials may be used for research and educational purposes only. Please credit the authors and the 
Center for Research in Water Resources at The University of Texas at Austin. 
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